Olur g5 doliy2 (513 g 9 51

(Android Studio)

J:L““" _h (,r;:iv

ey yin
L ol uiige
néb'u\.w L&)M VRS




Deitel, Paul J »- 1454 oz b oo -
UL el ore et JRs - Rl Gl 4aly (5l gyl

00ljiene Lo juee

FRPAGFYYY - FFFVVARD : als

AAYAAYEY o als

AR ! ol prARs
9/8-60U-196-093-2 . Sols
- 5 g C.u.n)Q.S e
Android for programmers. : Lol -lgie ool
daliojly : Sadlooly
Android (Electronic resource) ( Sus 25l aia) wg,nil : Esoye
dngi g (>l — (505 lidle s Eyeye
Application software -- Development . Eyo9e
e = VYOV al g« laL 00938l awlid
p e = \YFPe Lo jaem sl jdos 08933l awlil
QAYFIYF [A0AT Y TA0 OSS (gudy 00,
TVPN[' b SHS L 03y
FOVAFY S ke (swliolss o Lot
(Android Studio) ;ylus g ol y ¢l 29,0l : ks pl
Jes— Jua albe
odlifas 2 iaie — Lol plyge : O e
Csbanol : b
JLSRuNE S
O - Lo o
WA -l Gl
AVA-P 1 =) 49— YLD s YO Sl
ISBN :978-600 193 932 ol"j' YFess - .'.,_.-9
T Ol 55w 8

VIP ojlad —( By sy il (slaged Qlbisr (g, sgla (6500 aged UL - Ml

FREAREYY 485,00 -$FF ¢ 1 YOO :00ils

(Jﬁla] QL..I:'»L..:)

(T b ) 1 osled olkdy

L.;lZS' d.g-)ljl‘; - l.J‘JQ'; NLEHK d.il:'v).:a‘a $9p9y — il

(WT o) Y osled olly B

VWYY o e ~u.,,.:.-_a-'.;-_.a,s,ﬂ_:.;lﬁl¢,ﬁt. - 85 lees )5

2l 3l (and b plas S 2 el VYRA o gt i 2 3 oliceie ()i 3 G 51 ol (39 paa i1
3 a3 gl Sy S 40 Sy UL S b 82l a3l gy Al



: dove
O35 59y b 3 Lipe 65 o 8 s wlis GBS 0l 31 eolitiad (gl ) 995 Pgenald 5w ol o
it 5y S gy s oy ety ol Al 51 B g y50) 5l icint s il amsgi gl
htp://www.deitel. com/books/ AndroidFP3

xS aslizad o 908l sat sals JUR RE RO PR 385 & a5 S1G
SIS 9 (5 5#1p 5 ol 3
eanlta (g1, 00 0o Mac OS X L Windows, Linux ol S 4 5L aryg il slodal ) anwgs 5l
el aegly 5 Cal ) ale prons Sl 0 Gy

http://developer.android.conv/sdk/index. himl#Requirements
slanl 1 slaliale i Slesli ol Ly, OLSS ol gladali S aanlye System Requiremer s hovy 4

‘e las )s'
s Java SE 7 Software Development Kit
*  Android Studio 1.4 Integrated Development Environment (IDE)
»  Android 6 SDK (API 23)

e L TP KT e

JDK (vava L. elopment Kit) cua

AIDK T ol ol slw 559 pload ool 7 (JDK 7) asee. t Jave Deveropment Kit g3l e oy 0l
APL L plmases g il o 900 gty Lai try-with-resources o ' LY g oo  Jluds Android Studio
29035 axzrlye pj ol 4 pS L OS X Ggag v TR T 5500 gl 09 go glomity iV o 19 o

http://www.oracle. com/technetwork/java/javase/downl. - s/jave-archive-downloads-javase7-
521261 html

Sl Jaall o s S st 1) g Jalescins o g 5 aealS 381 by calie g2 64 s s 32 dhei
2 I3 1y ot

hitp://docs.oracle.com/javase/7/docs/we. ote.. istall/index html
ity APL glag, ool 3 agualaife tambda ol ailen Java 8 Lo sla Fig il 55 eyl
det fuaton ;S ooliiuul asund ol L™l gladal  olows] plfin &) 08 aolid JDK 8 5 NV [ PR EL
wieiS5 o0liil 393 (slaas 3 Java 8 L5 sla Shy a5 oo
Android Stutio vl
=t g Sl 0t 48| g T SDK (Software Development Kit) a1 5dyaar of o 41 gasstd ayg il
Gl ay 3397l gy )l 0glils g1: a2l oo Inteltid IDEA s, JetBrains 5\ Java IDE

http://developer.android.com/sdk/index html

1) 00LS caatd D9l (b oSS 3] s 1S S Download Android Studio aaSs (55, p g 0t axzlye
oy el 03,5 sl gragiosl iyl (e WS S0 JLis | i gl foallgzs g 00 5128
dmd e by b Sladas 88 oty Cn b ledh 4 g 00 all i a1 slezil o Complete Installation
oyl Bl 0 15 asuas g oy (6l s 1.4 geogiadd ayg il w kS 1l nad 4ty ey 0

e oy gz G Sl s el slool8g )5 il b Google Play s all)l gfy aoli y clis alSa &



% Ol gianlp gl gyl 4

Lo g ool glaadi s oo dla Sha s U ooyl biled 1,055 eoliiul gragil ag 0l sad 4o e

il n 5 oo piiie Beta Channel o Canary Channel ali; |, s (gl 858 i IS g0l 9y,
S ) 4 2 e b ol A o Fear b geogied )]
43S 3l 1) pognest ygpail )
S S8 Configure (54, » Welcome to Android Studio « s o =Y
A5 SIS Check for Update (59, 2 -V
a8 SIS Updates G (sa; p Platform and Plugin Updates  Jols o5 o -F
ewly o ;3 451, Beta Channel L Canary Channel o2 5L ul cuud 5l Updates  Jols o5 1 -0
Wi ezl o yle |8 Automatically check updates fr S 4
w8 S5 Close (g9 0 gupww 9 05,50 S OK (59 p —F
S S8 Check for Update ~q, 1 lodos =¥
Wi oo EM Lok & 1) lgil 0929 g 09, T b Lo g, 0 gury s 4 IDE -A
225 SCUS Update and Restart (5o, g2daml dun it %l 5 50000 cuai gl -4
Welcome to Android o,y J IDE candle azus 1y 0355 5 audily ol )5 Ju g vemad ayg il o (glosg e D3 51
s (59, y= Updates (Jolo oI5 & il oo w90 cnl 16 S 00 N eha 0 A g 035 b Studio
Help>Check for 3,k 5l S sid 15005 59 = s Aldror . Stuw,s>Check for Updates... 5 ,b 3| Mac
Android U dolisjf o Sledlb! oS (gl i o lals aor 3ads al8 5 s a8 by | o 2is Update...
w8 Wil g5 ol i Studio
http://developer.android.com/sdk/installin /studio-t1. .html )
bd lae jlack las () ps 920 giaul 39,80 (3 Sy
JUob sl g i )3 led St n 8 plaS LS o, gl o e gasgiial g il o8 e gl
a8 JLis by 55 € o S ol 0 aadh 75k gl Jlie (R 10,5 el Baa b Thg ol 00
-(Q) A58 5b )y el dyg il <
SAS Settings 5y, vy —w g 03,5 SIS Configure (g5, » Welcome to Android Studio iles L -
72 Logie jlaagics all Welcome to Android Studio o, 51 542 5L Defanlt Settings o ey b oS
il gl S el 350 g 53y »— L Android Studio>Preferences... sl gl Mac (o,
w8 oolinul File>Other Settings>Defanlt Settings, ..
Show line 45 wyg b fekae e 00,5 Llsail |, Appearance g sals 5 28|, Editor>General » 5 -
' B35 SIS OK (54, 2 5 Sab ok bl mumbers
S5 (S s (6 yalh (610 9 gl g 55T (sl Sy
Sy 30y A5 it ki Sy ool Sand lnd (cde-BOdinG) aF 0,8 gar (55 42 B Sy Al
S BCHIBCY EVPP R IPEL TS I g7 PO W ORI KA QPP DURE S S
fas o, 3 il e e oSy J5 L adipd olags g ol Sy 5 sl on ol guie oS 6 3 o import
P ol e saalie Ll J5 g esls 5081, bghas (ol sl o Sk Siyge 53 &l 008 men



Y PPN g

03,5 JLa ) (L3 G 13 0 g lae SMaglS Sy ol 0,5 b s (sl o Jab i sy IDE
S8 la sl 51 Show code folding outline 4z, 38 Editor>General>Code Folding = e
. Android 6 SDK
ol jon Android 6 SDK « b8’ ol (e (e} 5o ilond andigi Android 6 jl oolinul b LS ol (sla Jlte a5
ol e 4 i dales alien (1L 5u ddkd fp Asas g il B gladse ol et 05 grdgia] g il
sl Android 6 3' oolazl ¥ La diige u.,.llif Uﬁi 9y A )L{ Fli..k @ .OJ; L ‘_glnub)., Farea ) J.EL'..AiS )I &‘L‘
23038 gyl g B ety (cladstuns o 4 pladl Wiy, o
.(Q) S 5k [ gaagzad ..1._,’”..\.‘.7 -4
SDK Manager (g9, ;1 s g 03,5 LIS Configure (54, »» Welcome to Android Studio _sles L -Y
Welcome to Android Studio 8 iy Sl 059 ol )ﬂ w3 3b Android SDK 0yl LS SlS
¢3S by | g s Android SDK 4 Tools>Android>SDK Manager & )b 3 o - 1
S35 = g 008 D 0l Ll el 4 ol oF gy, 5| (cladse SDK Platforms wil; s -
Crigreh S go 800 | BLAI gladmes cuai g 35kl &4 & 3L IDE | w5 S5 OK g Apply
dilei cuai |y 0dd 3oy a1 laar L a5 oS Lad 4 IDE
AY. s (Ar ro'd Virtual Devices) atadl
S b Sg> )J,.:.:.qU Sy 2 I.muli).. d A lnl..\ii b aa - S . dy dg-’J.Iﬂ SDK BL ‘-‘:‘.SJJ‘T alda
Sl el (5550 gasg il ol o & (2B i D 5 el il W eSS
Ll alia ;5 &5 08 0 bl sy )il (6 3loma (sloelfae 2 L AVDs (Android Vitual Devices) o +,l5y! plo
QB3 ga e Syl laggidaliy g loe gl 1AL a2l g atenl 9 Sdes Ailgd ca Wlie igs
Sk lod dlaxr 5l il slo Fhg 3 0l e ves i s aily gleelSins g3 1 205 slaali
Slecudgise g Lacolld o anae b la T gl a8 i Jlsty Sigish 5 yadon USB <! g
Seiled (pigd 2y ol 5l ali
htip://developer.android cor*ols. Hevie .s/emulator.html
@S 39 4 i aiiles 0 80T 0 Cow ola e b LS| 0 Using Hardware Acceleration s
solizoal o0 ST LU 1 Gam by geels (GPU) (S8 85l aorly 3l sliiol isted wigd wlie
P saadis el 0D U5 SILS 2l oy (lilacke samoclis 00) wlie Intel HAXM 3
35 aslizl Ll 51 g5 g 45 Genymotion wilan &5 )b 3925 ik 1o 5,800
sloar el T Wiy a4y pilas o5 3l alfies S} pladasin AVD 8 sl oo S
Sy ez labed domis Pl @
S oSl e
Huled amio  Sord bl e
03y (g ilwo oz (510 8D &S agfail

O



% Ot gitali 1 (g1 oy gyl A

Sy o8 )8 45 08 Aol AVD pizr il o ehig ool o (i (59, 1 955 (glodaliy a5l
S oolidew| JF'o8" Cloud Test Lab 1 ailes o 4l o8 g 5ludns ;3 ds pamia olfows

https://developers. google.com/cloud-test-lab/

L o) opoms (giagyail glaeli s 3t g ey 6oy 1 ] s el 0,8 delt el a5l

35 IDE o oolitul (1,0 45 W3S o olam] AVD S, Lo (gl gsogiad ayg,ail WP e sy a3 e

Sl g Nexus 6 o-ali glaply J 958 0y il am o ol€20d g3 (6l AVDS jf Lo chliS l gl .ol 0t

gl ag il 15 AVDS Sy sl s gl ga o sl 3 itit ay g il a5 038 e solizil Nexus 9

o g0 Pl V- sy ;0 1) Android 6 AVDs slawl gz Juo ess a2l cosl 2l s

Ladals pa Coid (51 1 i g 50T 8180us Silaaldls

FolBu ol p 093 Canal as it St AVDS 5l onlitin! o 4 Sy it ol 5y ladeliy o

stmasliyy (gt ol ol sl Sl gadly loolSiund (g, 5o daih Lo Sp 5| g o L oty actly

oo oadd ool by gl Loaltygtuo Gug T UL (59, 1 3es
http://developer.android.com/tools/device. htmnl

SleolSe s gl Windows USB gl 10 jli any,lo | ja0iag $9) y e (eb, rad Lol S oS il

23 el 3l i B glans s ay 3laie USB g fs glacal o) o als, &l s aalgs oa duy Wl

VSRR )T

hitp://developer android.com/fools/extras/oem-usb.htm]

wlhs sla JBa o alily

Conl 005 Lo 25 Culuw o s aglily (gl LS Ol pesa o5

hitp://www.deitel com/books/AndroidF >5.'
Loy figaral S 4l Las Jlo golom 00w TTP L 4 ) Ll 15 08 (SIS Download Code Examples S5 545 p
Ll bl as Jleogiunzii o) bos s Sl B ZIP LU (gg) g o Jale piinn 45 azgi b .ogd 25lils
..1,,.53 u:‘?"b’ 1) d.llobl.! )1)5 J’p‘- p:....:..u i1y )'.‘L"“.‘ )é

Android SDK ¢ Android Studio U Jolas Jf ja lss
QR g et A S oo 0985 BLlS Aalyr ol g 4 esgrad syl 85 1) 095 (glaali 51 LS S
2 0T slagenls 5 W sy &5 gy Gkl (LY (yaen 4 ity g 05T PN slolil b gragial uyg a6
1ty StackOverflow
btip://stackoverflow.com/questions/tagged/android
;5 Google+ Android Development axel> 4 4
http://bit.ly*GoogleAndroidDevelopment '
WS alfa o b g sig
deitel@deitel.com
Sl ool 4 29,3 U sz s solal aylos 5 aglils ; QLS (gloaS g i) Laliile 5 alod a5 59251
whayer Sl QLS ol dalllae 3 g Slgunal a8 LSl el Ly oy g0l



wJlao Cuw 149

Azdue o leds Olese

AW sttt s AT o ol b
Yo doddo V-1
Yo Ol 33 Jrlige g iy Jole: a9 T V=¥
Ys gyl gla Srng)-Y
1 Sug ] Jolesoin o )-¥
Y Android 2.2 (Froy M \-1-)
Y. Android 3 /o, ~bresd) \-F-Y
™ Android 3.0-3.2\ Yoney smb) }-¥-Y
™ Android 4.0-4.04 (T e C ¢ m Sandwich) \-F-¥
rY Ar_ oid 4 1-4/3 (Jelly Bean) \-F-&
TIY cntnsssronsanesisninnenmans sssnassosnmnsssnsonssantassssususstussssnssscansessarvalftoracy weee 2 aroid 4.4 (KitKat) \-F-5
Yo wese o AN roid 5.0-5.1 (Lollipop) V-~V
s e Android 6 (Marshmallow) }-¥-A
AR Google Play jl aoli p 29Lil> V-0
YA by \-F
i (eeesresenac. Software Development Kit (SDK) s g yai1 1~V
| R ———. 155 o (gount 93ali 1 - A
Fo N o ——— S 4 ) I B 0 (] 11 P U B
1) 395l 33 95050 o Tip Calculator o9, 0,5 3U1-4-)
FY sacissimnvorsomsereverilinaps Risored AVD obw!V-4-Y
A Aexus 6 woligh o 3ef AVD ga, » Tip Calculator asbiy ol ,211-4-Y
oY ST olfiuws S (9, » Tip Calculator asliy sly211-4-F
of 29,01 )3 sadali sl V-
bf o gy dnwgd sl 1-1)
BA Juad 00uK 1-1Y
Bt WO A 039 Job
#A dodis ¥-
Y WBsipes 59 T-T

#Y 095wl g )T Y-Y-)




% Gl giasl p (gbys s g 50T

|5

Y ImageView 4 LinearLayout, TextView Y-Y-Y
Y XML (Extensible Markup Language) Y-7-Y
Y doli 2ol Y-Y-F
FY Ganailel Y-T-8
£y oshodllops Y-¥_5
Y 4ol Sl Y-
FY 3095wl dy g5l glhl Y-¥-)
b g dader 0393 obw] Y-V-T
FY Create New Project Jolg ols v-v..¢
£b Target Androwd Dey ces al8 Y-Y-¥
a4 Add an Activity to W bile 8 Y-Y-4
FA Crstorr'__ *he Activity alf Y-Y-§
F4 coroan g ail o yaey ¥-F
74 cavmnr eamens i PYOjECE 0 iy ¥-F-)
¥ woverand srves vanenns y 90l glva pais Y-F-¥
¥y e senne -0 Component Tree sz ¥Y-F-Y
¥ eave Cnsenss snssnssenseneen dli 1 Adlis la U ¥Y-F-F
¥Y Layout jaul Y-F-4
vy A ot GUIY-F-7
yY ssavaes ornsed insassasmsanassassassanne 8 98 s GUI gt XML Y-$-¥
Y¥ sevsns rusnnl asverserseessansansances LAYOUSL 33231 1 doli  GUI sl Y-8
vy siap & paeal fyda il Y-0-1
Y o, e anli p ya50] o8l Y-5-F
W scammmsarigoris Reci o LinearLayout 4 RetativeLayout p.éi Y-3-T
s, T LinearLayout o= id puii Y-0-F
Y4 TextView 4 glaio text gid il gavas i T-5-0
As TextView & jhaio textSize aacas eabaid Y-4-F
AY TextView a glaio textColor damas galiss Y-5-¥
AY TextView &4 dlao gravity dacas a5 ¥-8-A
Ad TextView 4 jlaio layout: weight aawas palisi Y-0-1¢
A$ Myl hulei ol ImageView g3 ¥-4-11
AA ' ok e g Y-8
4. Welcome asli 3 ol o Y-F
43 Aol 10 5 alailed T-Y
ar dali g o0 o8 | ool g Y—A




: D

Ay gy & ilaglna ¥-A-1
ar : e qalin (51,0 Laadigy (g i8Rl Y- AT
ay dali p ay o0l dooe o7 aidiy (e 8 Y-A-Y
a¥ - Wiy (38, (eloce T=A-F
LY AVD 54y p plibnd doliy cud V-A-0
as olsnd (G9) 3 (g2 dlonn! ol 2 Cond Y= A5
y &5l slona ¢ TalkBack Y-A-Y
ay i o ] Ko Yok
ay S48, dasm 3 Y-A-A
A Jad on A T-4
AN\
|E3 a3 ¥-3
1Y Tip Contator ok p cud ¥-¥
»r g 1S 1 5850 -
.. o N———————————————— O ». Sotivity GuSlS Y- ¥-y
¥ A fivity adis pec 4 T-Y-Y
1-F AppCompatActiv .y .. 45 g appCompat ailsnls ¥-¥-¥
-8 swerrsel e Gr dLayout b lagra slodos Y-Y-F

18 cornnreas Properties g Component Tree glvoyay o 70 o070l b GUI g jlwdiags g ol Y-Y-5
9 Slas! g dd T-Y-5

Yeb svnsenrsnnssnnssmmeancese EQITEXt 30 e o w8 ( Ty (51 TextWatcher dawly 5 jkwooly Y-Y-¥
29 el Coaden podi S0 w0, OnSeekBarChangel istener liuly gjlwesty ¥-Y-A

Vo F s SeekBar

VoF i slee ¥"-¥'-4
V¥ Myons Laas Ly g elevation :atge oyl T-T-3e
¥ i) alga o) ¥-Y-1)
VoY AndroidManifest.xmi ¥-Y-1Y
¥ Properties o iy ja gomiuss ¥-T-1¥
VoA GUI cslo Y-¥
oA GridLayout s ¥-¥-}
L] TipCalculator o}y Sl ! ¥-F-¥
1% GridLayout & pdi V-F-T
LR SeckBar ¢ TextView, EditText ;o438 ¥'-F-¥
"y lagy g 5ludings -F-2

W p Sy s iludiags 9 2 B e i Y0



ﬁ Gilmgiaal g (shpr uy g0l

i g

"ws

parent gla,g ¥--4-)

He

5 SO (g5t T-0-Y

oS ol 3.9 dsmad S idee polda ¥-H-Y

aolip idass o9 41 Y -5

import 4 package ol lc ¥—5-1

AppCompatActivity j| MainActivity S gy Y-Foy

Aignd g pOUE olb yuiin Y-5-F

Activity ;lonCreate as Cig 3l Y-5-F

MainActivity jl calenlator sin Y-£-9

OnSeekBarChangeListener luuly ouiss ssly albi o JPLES N L o 2 2
TextWatcher lawlg suiis esla plg o WDIY-F-¥

w A idManifest.xml ¥-¥

« M5 nfest paie Y-¥-4

wener . AP dication peie Y-Y-Y

seosuss wars’ meanes BCHVItY pois Y-¥Y-Y

-

P intent-filter pais Y-Y-¥

Ling

I \ =

T T PRI T B UL N

wa dasia P
yr§ L, e Flag Quiz 4l y cuud F-¥
"W a3y Coloudial g Sy F-T-d
A b VTR S b
1f. W, osialess » 5950 F-T
1Fe WLy F-Y-)
1L SO PEAR TR ¢
1$3 e b slaia yas 4 o P-Y-Y
Y B euialy Ca s F-T-F
FY Preferences ¥-V-4
1Py assets Ay F-Y'-%
12 Lo lhddigy FoT-Y
1F3 e glite Silndo 1 iy F-F-A
Fo NUEHRSCHPIRIr L M
4 rl pliny faloi 51y Toast F-1-1.
1¥5 e 313 5 40 cyudepoil Jlol P ¥ 1Y
\£$ 1339 97 bedl Slows1 gl ViewAnimationUtlls 31 ealizu! $--1Y




S W

W
Py 319 Soprdy bl 55 Cens F-Y-1F
FY AlertDialog ¥-Y-14
FA sLazal glaaliny cui F-Y-15
YFA Intent s )b 51 5 e 51l F-V-1Y
V¥4 lalar slaasls qlazslu F-Y-1A
¥F4 SE 7 lgl> sla Sy F-T-14
Vo AndroidManifest.xmi -¥-Y.
Yo P00 S g 2a olo Ll gy Slow | F-F
1o o5 ool F-F-y
144 Blank Activity o481 T-F-¥
1Y Java SE 7 jl gl F-F-Y
8y oias & pr pobal oo iy F-F
1oy 23 gla U String Al *ring.yml F-F-4
ey o AT sxml ¥-F-F
[T+ sorses wnaee OlOrS.Xm F-F-¥
[} « bul on ext colorxml F-F-A
&% Db mainxml | Sabp e F-F-4
by v P gp Sy Clbitad| Slong | F-F Vs
164 weo boli p onoulaid sl w preferences.xml F-¥-13
| S— o395 « SettingsActivityFragmen. - SettingsActivity cla M5 09 381 F-F-1Y
AL ke doli yy GUI sl F-0
W PO TR 42 50 claelRiws (gl activity main.xml F-8-1
L5 RN, | S D e fragment main.xml s F-8-Y
WY Cserssrnsensananes Graphical Layout e ol ol alee FT-5-¥
VP A landscape cqe ;0 ol gl content main.xmi F-5-F
|1 AT PRSP RIS MainActivity .5 -
e import i)l o package < L F-5-9
W Wauked F-P-¥
134} onCreate wis i i iU FmFut
WY onStart uis ois yai 3l F-P-F
1hdd onCreateOptionsMenu aia iy a3 3k P-F-4
o onOptionsltemSelected oo iy a7 j4 F-F-7
e, sssessssennssss ONSharedPreferenceChangeListener sudis soly ol o Jolo W5 F-7-¥
vy MainActivityFragment 55 £-¥
WY import 4 package o;le F-¥-1




g b giaali pr (gt g y0il

f

WA loali fF-¥-Y
e onCreateView uzs iy il F-¥Y-V
Ad updateGuessRows ww F-Y-F
1AY updateRegions a0 £-¥-5
YAY resetQuiz os P-¥-§
1A¥ loadNex{Flag aie F-Y-¥
YAF getCountryName 50 F-Y-A
1AF animate axo F-¥-4
Y OnClickListener sasis aoly pli o ol | M5 F-Y-1s
A- disable utty ~v aze ¥-¥-13
. SettingsAv “vity oSS F-A
" SettingsActi#*vFragmenc M5 F-4
141 weAln roidManifest £-1+
iy ers sameas vanvens Jitd audaSie F-1Y
————— X (]
11y DR PYLY-7 3 O |
A s racens aennn AVD) j3 Doodlz aoli p o H-¥
T crnrsosseesatssnssenssssemsemssssemssesssassssansssssseness | oose 3o eSS (590 B-T
Yoy Aol g 3 9381 ok 45y gladce A-T-1
Y.y gl lag g 8- Y
Y.y N SensorManager 3 colizul a-1-¥
V¥ erenmn o slaw DialogFragment A-Y—¥
Y-¥F - Bitmap 5 Canvas, Paint b e i 8-1-3
Yed co g Path 10 bglas 05u5-5 ¢ caclian gl sladlasyy gijl p B-Y-§
Yol ciisiimenersensansonse nslins S 3 3 )T a3 AT
1.d \, PrintHelper 55 5 ola 8-Y-A
Ye$ 6.0 wayuil was slajame fuo d-T-4
Y. Gradle Build s b | Sty (0938 8-¥-).
Yop il g 03 Sl B-F
 E . o585 Sloxsl H-F-)
Yoy 0308 & bl GUlS 5938l :Gradle A-F-Y
Yoy . strings.xml A-f_¥
YoA s s (1 a5l (50,5 3y B-F-F
YeA I MainActivityFragment goio 5-¥-8

3} AndroidManifest.xml 4 jame 53938 &-F



s Weowes &

rit ol GUI el 8-
™ . MainActivity g1, content_main.xml 51
g1 MainActivityFragment g fragment_main.xml d-A-Y
VY ColorDialogFragment o1y fragment_color.xml 4-5-Y
T LineWidthialogFragment !y fragment_line_width.xmf 5-5-¥
ny EraselmageDialogFragment w5 04381 8-4-8
riv MainActivity M5 6-%
YA MainActivityFragment 58 8- ¥
4 lasld 3 import, package ol )L 5-¥-3
Yy onCreateView Jao oas 30 3L 8-Y-Y
rY. enableAcceleromterListening y onResume slak 6-Y-Y
m disableAccelerometerListening s onPause gla 0 V-¥
Yy el gladlangy Wil gl b -0 l3ls WS o-Y-3
rry co. 'rmEr, e aze H-¥-F

T ¥ s 0nOptionsitemSelected 5 onCreateOptionsV cnw clae & aish &-Y-¥

vh sesnenss wee § AVEIMIAge aza H-Y-A
Yy onRequestP-—iss, nsResult s wi p253L A-¥-3
vy setDialogOnt ‘r¢.a 4 etDoodleView laocs 8-Y-1.
YA DoodleView M 5-A
YYA import o package o)l 8-A-Y
YA diged 8 STl gld puine H-A-Y
Y4 e auijlas B-A-Y
vd arearsl sraarassessesraeres ONSIZEChanged vie Gy pui 3k H-A-¥
YY: .. getLineWidth y clear. setiva i\ 7Color, getDrawingColor, setLineWidth slaszs 5-A-8
Las] - A\ onDraw Jie i 5L 8- A-F
i . o onTouchEvent ois (b i b d-A-Y
Ty 3 touchStarted win 8-A-A
Yy touchMoved azs &-A-4
vé touchEnded v &—A-Y-
rYa savelmage ais d-A-1)
rr printimage ss.e &-A-1Y
ey ColorDinlogFragment .M A-%
Yy onCreateDialog aio s pri 3l 5-4-1
Y4 getDoodleFragment e &—3-Y

Y4 onDetach y onAttach glaazs by i3l H-4-¥




g Olenr g5 aali s 5t yt g g il g

¥ SeekBar glastisay 41 87l ali g 515 M5 A9 F
Yf. LineWidthDialogFragment M8 4-1-
Y¥Y onCreateDialog ace 81+
YEY WidthSeekBar glnolag g, 4 o feuly plig A1 WS 8-1-Y
YEy EraselmageDialogFragment o8 54
Yfd Jab oS B-1Y
YFa doudo F-9
Yo Cannon Game asbi y; Cowi $-Y
Ya- g aleil ™ » (590 F-T
Ta- res/raw wlg Losuwl F-¥-)
Yo Fragment y Activity ~c ds o guodie F-1-T
yol onTou * Evem o i il F-Y-Y
Yo AudioManager o, ndy i G foue 0438 P-V-F
Tl SurfaceHolder y Surface™ o (2 6 b w3 a3 u1 38 copdamonil F- Y0
rar 3535 3 Al PoY-F
Yoy ras mrer Drassassasreesrerseas [NMEESIVE 0 F-Y-¥
var : &n o llh g GUT colus #-F
Yar a3ap oloal F-F-)
Yor app dlao ¢ lgas i ol pd puliid F-F-Y
TaoFf ™. W strings.xml #-¥-¥
Ya¥ ) s, FF-F
vaf asliy 43 o ;yog 38 F-F-D
Y&F cnsremnissninnissensensent hoessligar MainActivityFragment )5 o438 $-F-5
L - TN . ) activity main,.xml ol g F-F-¥
Tad fragment_main.xml «; CannonView o439 $-F—A
Yaf 4ol glb WM g a0 F-0
Yoy Activity 3t oSy ; MainActivity 55
Yav Fragment j . 5 ; MainActivityFragment 5V
TOA.... GameElement M £-A
A ] asenes Bukb 3l g diged glb e F- AN
Y5 playSound 4 update, draw leia $-A-¥
Y$) GameElement jl S i j Blocker 5-4
YA GameElement Vg5 p j Target #-3+

YrY Cannon M #-1



W e 4

Y5y . o jlur g digei sla pudiio F-13-1
roY “ align uze #-1)-¥
YFY » fireCannonball oo F-11-Y
e dd I draw s P-41-¥
Y#b removeCannonball 4 getCannonball e £-11-4
Y& GumeElement 3| .5 3 Cannonball $-1Y
Y#o ok Lo 4 digad  5lo poiia F Y73
YFF einanrenismansesnann TEVErse VelocityX 5 getRadius, collidesWith, isOnScreen glauia F-Y-¥
ey update 450 #-1Y-Y
TeY draw oz F-{Y-¥
Yy SurfaceView ;1 .My ; Cannany w F-1Y
At import s package &, < F- (T
Y7 't g g sl e FIY-Y
Y. KIS iy
¥y onSize ‘har, d w3l F-IV-F
Yy playSound g getScreenWidt} -etSc cep feight clausce VY-8
vy coren eain - Ceane NEWGAME 06 F-1Y-$
T N mnirm s sn s gt ey sy n e s smgatlans 8 cesaens e ipdatePositions oo #-1V-Y
TYF e AlignAndFireCannonball Jze #-17-A
VY showGameOverDialog ase #-1¥-4
YA ssivee visens ssnsenssaneenss GrawGameElements dce §-17-1.
AR A O ER SR AR ———— (1 1] O 12311 ERNEPS B R b
YA+ releaseResources s stopGame glaoce F-17-4Y
YA canser vrenessanears SUrfaceHolder.Callback slauis 53lwost -V 1Y
YAY onTouchEvent oo Gy pai 3L P-1Y-1F
VAT cicnrmsnenisansranencdnennns wearert darensensenss 650 aiida- Sl ol 7 5l soliius] CannonThread F-17-13
YAT showSystemBars 4 hideSystemBars glaoz. 717~V
TAL et 0.5 F-AF
. |
YAR doddo V-3
Ya. Weather Viewer doli pp o ¥-Y
ra. Wiy o g0 ¥-T
Y4y g o Sha g g e ¥-T-Y
Yay Org.json 5y 3 JSON V-1-Y

Yaf HttpUrtConnection b4 REST i g s wog lest, ¥-Y-¥




g Glsgitaliys (513 p9 0 1A

Ta¥ AsyncTask a5 ¥Y-¥-F
Tad View-Holder o8t 4 ListView, ArrayAdapter Y-1T-4
Y&y FloatingActionButton ¥-Y-#
TAF TextlnputLayout v-Y-Y
YAY Snackbar ¥Y-Y-A
Ty 2o sl Litd 4 GUI b ¥-F
Yay ojap ol | ¥-F-3
YAY AndroidManifest.xml ¥-¥.Y
Y4A strings.xml ¥-f-¥
T3A ceolo. xml ¥Y-F-¥
T4A activity_m. ‘w.xi V¥-F-4
¥44 cotont_main.xml ¥-F—§
Yoo | lis item.xml y-¥-¥
Y.¥ arens weeens - Weather U5 Y-4
Y.y aigni b iie o meck wge, import l,le V-A-1
vy stenne seriennennssssisrmgrnrreers 00l Y- A ¥
Y-¥ « . cor vertTimeStampToDay a0 ¥-4-Y
Y o F iitenaerisrsnessn s sensans st st rmarnnrasmsansasss inese, WentherArrayAdapter 55 ¥Y-#
vf import 3 package &l)le ¥-£-9
Yad ViewHolder zq5 ;045 55 V-5-¥
L > YOVOGURINRRSUPRRER— .. 3 ooyl g diga pudiio ¥-F-Y
Y.# omnes getView ais iy aijl V-5-F
YA e e sennes |20 B 30 alial Salilo 6y S AsyncTask Y-5-4
1. ™ N MainActivity  oMs ¥-¥
I LI ETINREDRRTR N SN import ¢ package &)l YY1
i) \ Aigad 5k yuicio Y-Y-T
™ onCreate ais iy a3 )L Y-Y-¥
iy createURL 4 dismissKeyboard  glasce ¥-Y-F
i g oy Jlaslyd ol i 5 AsyneTask ¥-Y-4
Ty : convertJSONtoArrayList uos ¥-¥Y-5
iy ; Jad oduSia ¥-A
m f doads A-1
YYY a aoli p Comd A-T

vy algada (ggomimar 08380 A~T-Y




" e o

vy ' s gulis rlad A-Y-Y
yYe ; I enLuer gloie A-Y-Y
\hed - PEINCPR TR (S PV A
Yre e Bde A-T-0
Yry ool o i slagaima lao 30 g Sl A-T-F
YTA 5399955 2 4908 A-Y
YYA SharedPreferences U ;o jlade- auls 000 500 A-Y-)
YA Intent ,¥'oliil g goé Intent A-Y-¥
rTA RecyelerView A-Y-Y
Yra RecyclerView.Viewlolder § RecyclerView.Adap’-r A-¥-f
Y. RecyclerView. ItemDecorau 0 A-Y-5
Y. AlertDialog jo bdi 3 condd 5 i 1y-V-7
e &0 5l A GUY sl A-F
rr. vormsn €9yt Dbl A-F-)
Y. Ap .. vidMd.anifest.xml A-¥-Y
Ty voeyek Vie w ailsgly -ag3 A-F-T
e PR —— ] [ 105 411 LS S 8
1 g SRR ER R LRI FISMTUI O PRIy WO covsons wsnssassnnsensesneens SUAANES. X1 A-F—3
ey T arrays.xml A-¥-§
vy dimens.xml A-¥-Y
Yy P D — .\ VL L RO FUINCPEE T S B §
ey e e, activity_main.xml A-F-4
1 [ I SO content_main.xml A-¥-%.
Yvae Cmre aneans list_item.xml ;loo.s A-F-1
Yye MainActivity w55 A-4
bl g SCESTROR R D, TR import 4 package otyle A-4-1
vy MainActivity claals A-d-Y
YYA onCreate Joa oay o2 3l A-4-T
YF. updateSaveFAB uzs g TextWatcher slou gy Jois A-0-F
Y OnClickListener slage; A-0-4
YEY addTaggedSearch ws A-4-F
VP cevconsanonnes A ar il | puilod g1 p View.OnClickListener suiss adly ol o (oo | WIS A-0-Y

U gty o6 01 ol as gl View.OnLongClickListener eucss asly pli g S35 w5 A-0-A
AR FETEST 5 e8

vEs shareSeareh oo A-0-9



g Obmrginoli g g1y oy 9y

Y

Y'Yy
YEA
YA
Y¥a

deleteSearch o A-0-1-

RecyclerView.Adapter ;l SearchesAdapter S ;5 A-F
owi jls ¢ dignd sl yudkia dmport oyl package Gl AP

Y¥4

ViewHolder 5 13¢5 M5 5 A-#-Y

Yo

RecyclerView.Adapter lasse Gy paijl A-F-1

vay

TtemDivider 5, ; A-¥

rar

rov
raA
vat

Fabric b bLs ! 8 I A-A

dlas oduSiar A-4

PRI B

o gt 4T

eves LS K 939 8-Y

Ai-h

S0 Sy st lei 4-Y-F

Yo

L N B T TR e E

Y§e

wwaren seane 2o G Sy Bder 4-Y-F

5.

e D U S ST 5ga 00 AT

YFe

Fregn v (ral sactions b lecied  foled 4-Y-1

¥#1

wne sl s o g8 g COaflyd s 20l BLI 1YY

YFY

SQLite ools sl o o 4-T-T

YFY

seassss wransnd oo ContentResolver y ContentProvider 4-Y-¥

YFY
YF¥

YFY

Yy

serens evensl emsensansansanssasinres, LORderMansager ¢ Loader 4-Y-5
searmasl TextView aiwoj g 4-Y-¥

2o sl filé 4 GUT bl A-F
ojay ol |4-F-)

v5$

aoli g glw S olws 4-F-¥

doliyy olor oy Kol aq38l 4-F-Y

Y#F

strings.xmi 1-¥-¥

TrY

styles.xmi 4-F-5

YFA
YEA
Yy
™l
VY

Tv¥
Tvf

textview_border 4-F-§

MainActivity ;lodus 3-F-¥

ContactsFragment 5loaus 4-F-A
DetailFragment oo 4-F-4

.AddEditFragment looas 4-F-1+
DetailFragment geie 4-¥-1
Jad gl sl WS g 2544



il elae G yob W’

Yv¥F ’ DatabaseDescription o5 A-#
Yvs " S il slburled 45—}
rvs & Contact gy ;395 O 4-5_Y
vy . AddressBookDatabaseHelper  ,o)M5 &-Y
Yya AddressBookContentProvider 55 4-4A
Y4 AddressBookContentProvider glaalid 4-A-)
M getType s onCreate iy i 34 3-A-Y
A query Joa s i 3b 4-A-Y
YA¥ insert Jio o a3 3L A-A-F
YAd update v iy b A-A-b
YAV MainAct. [ty _ My 4-4
TAA oduts oalu glanald g bndowly o WSS 5w 440
YA ContactsFragment.ContactsFragm ¢ _iste. v 5 au50 4-5%-¥
Y4 disp ~vCr dact wie 3-4-F
a1 displa, A7k 'Tragment Jois 4-4-0
Yay DetailFragment,Devas “rag. ~.cListener glvics 3-4-%
rar AddEditFragme ¢ Ar Ediv. ragmentListener oo 3-3-%
Ay strninl vesrrerens e CODEACtSFragment i 4-4.
rar W Dl gilwealy daaly g WS 4 gew A-1e-)
f4F ContactsFragmentListener 4-1.-Y
rib i oald 4-) -1
rab ver ens vesmsanrarssasassessanransss ONCTERtEViEW dio i a7 3l 8- Ye—F
Yas Y onDetach yonAttach cis pai3h 4-Y4-2
Tav onActivityCreated oo i o7 jle 4-Y+-
Yav B+ updateContactList 4o 4-V-Y
T4A LoaderManager.LoaderCalibacks<Cursor> slavic 4-1+-4A
Yaa ContactsAdapter M5 4-1)
L AddEditFragment 55 4-1Y
FoY aduis a3l Louuly g | D s g 4-17-1
Fer AddEditFragmentListener 4-1Y-Y
Py Gaidad 1-17-Y
fer onCreateView 4 onAitach, onDetach i a5 5L A-1Y-F

Fed vinannsinn UpdateSaveButtonFAB s ¢ TextWatcher ameChangedListener 4-1Y-2
Frfumanmmonna saveContact ais g View.OnClickListener saveContaciButtonClicked §-4Y-#$
F-¥ LoaderManager.LoaderCallbacks<Cursor>  clasis 4-1¥-Y




% Olwt gidol p g g9 39,05

AR g

oy

Feq

DetailFragment M5 41y

2 800 Jaanly g WIS o g 43T

DetailFragmentListener 4-1v-Y

Wl 4-17-Y

onCreateView 4 onAttach, onDetach glauio i a5 il 4-1Y-F

onOptionsitemSelected y onCreateOptionsMenu i 2534 4-17-4
DialogFragment confirmDelete 4 deleteContact sz 8-Vt-§

LoaderManager.LoaderCallback<Cursor> staaic 4-1¥-¥

il » S A 1F

—‘

14

doodic Yo%

14

ST gl By 05 g 0-Y

¥Y.

Semesn o luxh"uu: 1+-¥Y-3

FYe.

u‘-l‘ ‘q,." . wilad Mucﬂi',ﬂ Yo-¥-v

FT.

ARy | V- T YOI IR T O o

!

o, TV SRR e

Yy

m

PRV RRC P PP SPICINING J-SL g U PR g |
W 6 lwomiens Vo-Y-F

A
FrY
fry
¥rY
FY8
Tro

Pry
FYA
FYA
fr.
fr.
£
T
FYY

aaliyy |y d cbdnl gyt poguas oS Sl jo Yo Yoy
o N Rrissssssssisissasis daly g 3 gyasad wagh Vo=

..... RswseD 4ol g aicg s Yo—¥-4

ervrres . Sl plmeaaliy o 108 55,01

S UJS'E ‘shuu‘g Yo%y

s gl Voot
in-app Sliad b gl jnel 50 14—

...... Silme SV g b ol in-app billing ageds iacliy  gljuel ;0 Vo2

Google Play ;o o s Vo8

SS9 59 65l o gy b 43,5 b gy VoY

Google Play 41 laasl y 0,5 29liT 1e-A

dali o950 3t Play Store ol yol 14-4

Google Play ;o 4aliyy o ke oo

X a19)8T 515 il Yoty

s Jilige aeliyy slop S il 1-—9Y
4ol 13k 00T




